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Introduction to the Hygrofox & Co. 
 

Dear customer, 
 
Thank you for choosing the data logger Hygrofox (Thermofox 
Universal incl. climate sensor) from Scanntronik Mugrauer GmbH. 
This provides you with an extremely powerful data logger for the 
analysis of climate data. 
 
The data logger consists of two basic components: The "Thermofox 
Universal" basis logger system and the attached Thermo-"Hygro" 
climate sensor. The measuring system has been specially developed 
for the display, recording and analysis of humidity and air temperature. 
In addition, up to two external temperature sensors can be connected to 
the left side of the basis logger system. These sensors can be used to 
also monitor the wall temperature, radiator temperature, outdoor 
temperature and much more. The attached Thermo-"Hygro" sensor 
measures both the air temperature and humidity and can be separated 
from the basis logger system by means of an optional connecting 
cable, if required. The system offers a clearly arranged display on 
which the various measured variables can be displayed. If desired, the 
display can be switched off completely. The two AAA micro batteries 
used in the data logger can be replaced quickly and easily, so that any 
measuring task can begin without delay. A regular calibration every 1 
to 1.5 years is recommended and guarantees the successful use of the 
measuring system for many years even as e.g. appointed construction 
expert at court. 
 
Within the scope of this manual we would like to give you a basic 
understanding of the use of the Hygrofox & Co. If you only want to 
use the basic logger system "Thermofox Universal" without the 
Thermo-"Hygro" climate sensor, you will also find all necessary 
information and explanations for its operation in this manual. Only the 
functions relating to the humidity measurement will not be available. 
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The core components used in the application of the measuring system 
are the data logger hardware, up to two optional external temperature 
sensors, possibly some heat-conducting paste and the PC analysis 
software. In addition, there are other components that can work 
together with the data logger. These components include e.g. the 
Remotefox extension for remote data transmission, an SMS alarming 
system, a portable mini printer and many more. However, these 
components are not described in detail in this manual. 
 
In order to be able to configure the data logger for the next 
measurement task, the PC software must be installed on your 
computer. Among other things, the software gives you access to all 
collected measurement data stored in the data logger's memory. 
 
For this reason, one of the next chapters deals with the installation of 
the PC analysis software. 

 
Scope of delivery for a complete system 

 
If you have decided for the complete “Hygrofox” system incl. PC - 
software, you will find the following components in the packaging or 
already installed in the system for you: 
 

1. Hygrofox - Data logger hardware 
2. Two AAA batteries (freshly inserted) 
3. Short instructions for the Hygrofox 

 
4. Data carrier (CD-ROM) of the PC software 
5. PC interface cable incl. manual 

 
6. Optional: External temperature sensors 
7. Optional: Heat-conducting paste 
8. Optional: Wall bracket 
9. Optional: Calibration certificate 
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Installation of the PC software 

 
Start your computer and wait until the operating system is fully 
loaded. This process may take a few minutes. If your computer is 
already switched on, please close all other applications to avoid 
possible conflicts during installation. You now have the desktop of 
your windows operating system in front of you. 
 

 
 

Figure 1: Desktop 
 

It can be one of the following operating systems: Microsoft 
Windows® XP, Vista, 7, 8, 8.1, 10 or newer. Newer operating systems 
are also supported. Insert the CD with the data logger software into 
your CD drive. Normally, the installation wizard will start 
automatically, which will guide you through the following installation. 
If this is not the case, the automatic startup function of your CD drive 
has probably been disabled. In this case, double-click on the “My 
Computer” icon and it will open. Double-click on the icon of the CD 
drive in which the data logger software is located. The installation 
wizard is started. 
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Figure 2: Wizard for installing the PC software 
 
Follow the instructions on the screen. First, you must specify a 
directory in which the software is to be installed. You can then specify 
a name for the folder that will be created in your start menu during 
installation. In the last step of the installation, you can create a shortcut 
on your desktop and in the start bar. Before the installation starts, you 
will receive another summary of the installation options you have 
selected. 
 
After the installation has been completed, you can start the SoftFOX 
software via the new entry in the start menu. The welcome screen of 
the program will open. Press the "OK" button to start working with the 
software. 
 
This manual explains the procedure for working with the Hygrofox in 
detail and gives an overview of the most important functions of the 
software. For more detailed information about all features and 
capabilities of the software, please open the online help of the 
program. 
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Figure 3: Accessing the online help function 
 
This can be done either by pressing the "F1" key on your keyboard or 
by using the menu item "Software - Help" in the "Help" menu. In 
order to be able to use all functions of the software and the data logger 
it makes sense to take a quick look at the online help. In this way, you 
will learn how to use the features of the software and the data logger in 
a targeted manner. 
 

Configuration of the PC software  
 
Before the PC software can work together with your data logger 
hardware, you must connect the data logger to your computer. The 
connection is made via the PC interface cable, which is included in the 
scope of delivery of the software. This can be either a USB or RS232 
interface cable. 
 
When using a USB interface cable, please note that you must 
install the USB interface cable on your computer before using it 
for the first time! Please follow the installation instructions 
enclosed with the USB interface cable. 
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Connect the interface cable to an available USB port of your PC (when 
using a USB interface cable) or RS232 port (when using a RS232 
interface cable) and connect the other end of the cable to your logger.  
 
The interface cable must be connected to the “Computer/Switch” 
socket on the right side of the data logger. To do this, first disconnect 
the connection cable to the Thermo-"Hygro" climate sensor (if 
present) and then connect the PC interface. After the configuration of 
the data logger has been completed, the Thermo-"Hygro" climate 
sensor is reconnected via the connection cable to the 
“Computer/Switch” socket.  
 
Now you have to set the right communication port in the PC software 
to establish a connection to the data logger. This is done via the 
"Program Settings…" menu item in the "Options" menu. Enter the 
corresponding port in the "Communication Ports" field. 
 

 
 

Figure 4: Configuration of the communication port 
 

Save the setting with the "OK" button. In this way, you only have to 
specify the communication port once. The PC software is now ready 
for the configuration or readout of the data logger. 
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Tutorial for the Hygrofox & Co. 
 

After you have successfully installed the PC software and two AAA 
micro batteries have been inserted into the data logger (these are 
already freshly installed by us shortly before delivery), the typical 
procedure for the use of the Hygrofox (or Thermofox Universal) is 
explained below. 
 
Each measurement task starts with the configuration and testing of the 
measuring system, i.e. the data logger. The first step is to test the 
battery status of the data logger. This is particularly important if the 
data logger is to record measurement data over a long period of time. 
 
There are two ways to check the condition of the batteries. Either 
select the "Battery Test" menu item in the "Options" menu or click 
with the left mouse button on the battery symbol to the left of the 
diagram window. The battery indicator is then updated and gives you a 
guide value for the condition of the batteries. 
 

 
 

Figure 5: Battery indicator of the data logger 
 
Depending on the set measuring rhythm, the number of active sensors, 
the ambient temperature and the frequency of PC communication, we 
recommend that you replace the batteries of the data logger system at 
regular intervals (e.g. every 12 months). 
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The next step is to set the internal clock and calendar of the data 
logger. These two components give the data logger the "feeling of 
time" that enables it to record measurement values at regular intervals 
and store them in the memory with a time stamp. The clock of the data 
logger is set via the menu item "Configure Time…" in the "Toolbox" 
menu or via the clock symbol in the toolbox to the left of the diagram 
window (1st symbol). 
 

 
 

Figure 6: Setting the internal data logger clock 
 
To transfer the current time to the data logger, just click on the big 
black arrow in the middle of the window. This transfers the computer's 
current system time to the data logger. Please make sure that the 
system time of your computer is set correctly. 
 
Next, the data logger calendar is set. This is done via the "Configure 
Date…" menu item in the "Options" menu. 
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Figure 7: Setting the internal data logger calendar 
 
You can use the "Use system date" button to transfer your current 
system date directly to the three date fields. The new date is not 
transferred to the data logger until you press the "OK" button. 
 
After the two time-determining components of the data logger have 
been configured, the sensors of interest during the following 
measurement task are selected. The sensor selection is made via the 
menu item "Configure Sensors…" in the "Options" menu. 
 

 
 

Figure 8: Selecting the active sensors 
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The configuration window is divided into two main areas. In the left 
area, the sensors to be recorded during the next measurement task are 
selected. In the right-hand area, the sensors for which the min/max 
detection is to be active are defined. 
 

 
Table 1: Available sensors and their description 

 
Activate all sensors you want to use, one after the other. If there is a 
check mark in the corresponding selection box, this sensor is active, 
even if the check mark is grayed out or hidden. This only ensures that 
the sensors are activated in the correct sequence. 
 
Without active min/max detection, only one measurement value per 
sensor is recorded at each measurement time. With very slow 
measuring rhythms (e.g. several hours) this can lead to overlooking 
extremely short-term extremums, i.e. these extremums will not be 
recorded. With active min/max detection, the Hygrofox regularly 
analyses the state of the sensors at short intervals (typically every 5 
seconds).  

Software Display Description 
 

Sensor 1 - External 

 

 
(=t1) 

 

1. External temperature sensor 
Input „Sensor 1“ of the data logger 

 
Sensor 2 - External 

 

 
(=t2) 

 

2.  External temperature sensor 
Input „Sensor 2“ of the data logger 

 
Sensor 3 - Internal 

 

 
(=t3) 

Air temperature sensor, integrated 
in the „Thermofox Universal“ 

basis logger system 

 

 
Universal - Sensor 

 

 
 

(=U1) 
(=U2) 
etc. 

 

“Universal – Sensor” connected to 
the "Computer/Switch" socket, e.g. 

Thermo-"Hygro" climate sensor 
U1 = Air temperature of the sensor  

U2 = Humidity of the sensor 
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If the data logger detects an extremum, i.e. a short-term peak value 
which would not be registered by the normal long-term recording, it is 
additionally stored in the memory. 
 
Please note that the data logger does not necessarily always record an 
additional extreme value at every time of measurement! If the climate 
surrounding the data logger is relatively constant or changes only 
slowly, it is possible that even with activated recording of extreme 
values no minima or maxima occur i.e. are recorded. This saves a lot 
of data memory and work during the later evaluation of the measured 
data. 
 
When the “Differential measurement: Sensor 2 - Sensor 1” is active, 
both external temperature sensors ("Sensor 1 - External" and "Sensor 2 
- External") are always used and automatically activated. The input 
"Sensor 1" ("t1") registers the temperature of the connected sensor as 
usual. However, the input "Sensor 2" ("t2") registers the difference 
between "Sensor 2" and "Sensor 1", i.e. "Sensor 2" minus "Sensor 1". 
By this means, for example, the temperature difference between the 
flow temperature and the return flow temperature of heating systems 
can be monitored very easily. 
 
The last step is to define the rhythm (the measurement interval) at 
which the data logger is to record measurement values. This is done 
either via the menu item "Configure Logging Interval…" in the 
"Toolbox" menu or via the second clock symbol (with the green 
section) in the toolbox to the left of the diagram window. 
 
In the "Logging Interval" area you can define the time intervals at 
which the Hygrofox should regularly store measured values of the 
selected sensors in the memory. After you have made the desired 
settings, start the measurement process by pressing the "Start Logger" 
button. Please note that all values stored in the data logger's memory at 
this time will be deleted. Confirm this warning. Depending on the 
memory configuration of the system, the active sensors as well as the 
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selected measuring rhythm, the maximum possible measuring duration 
is determined. Here some examples: 
 

 
Table 2: Dependency of the measuring duration on different parameters 

 

Memory Active Sensors Rhythm Duration 
4000 Readings Air Temperature (U1) 

Air Humidity (U2) 
15 Minutes 21 Days 

4000 Readings Air Temperature (U1) 
Air Humidity (U2) 

1. External Sensor (t1) 

15 Minutes 14 Days 

4000 Readings Air Temperature (U1) 
Air Humidity (U2) 

1. External Sensor (t1) 
2. External Sensor (t2) 

15 Minutes 10 Days 

16000 Readings Air Temperature (U1) 
Air Humidity (U2) 

15 Minutes 83 Days 

16000 Readings Air Temperature (U1) 
Air Humidity (U2) 

1. External Sensor (t1) 

15 Minutes 56 Days 

16000 Readings Air Temperature (U1) 
Air Humidity (U2) 

1. External Sensor (t1) 
2. External Sensor (t2) 

15 Minutes 42 Days 

64000 Readings Air Temperature (U1) 
Air Humidity (U2) 

15 Minutes 333 Days 

64000 Readings Air Temperature (U1) 
Air Humidity (U2) 

1. External Sensor (t1) 

15 Minutes 222 Days 

64000 Readings Air Temperature (U1) 
Air Humidity (U2) 

1. External Sensor (t1) 
2. External Sensor (t2) 

15 Minutes 167 Days 
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If you have also activated the min/max detection, the maximum 
recording/measuring duration is reduced by approx. 10%, depending 
on the fluctuation intensity of the climate. 
 

 
 

Figure 9: Setting the measurement interval of the data logger 
 
The data logger now measures continuously and stores the measured 
values in the internal memory. Disconnect the Hygrofox from the PC 
and connect the Thermo-“Hygro” climate sensor to the 
“Computer/Switch” socket via the connection cable. Next, connect the 
external temperature sensors to the inputs "Sensor 1" and "Sensor 2".   
 
You can now place the data logger anywhere you like and use it in 
your measuring task. To achieve an optimal result when measuring 
surface temperatures, please proceed as follows:  
 
Apply a small amount of heat-conducting paste (approximately the 
size of a pea) on the surface to be measured and embed the front part 
of the temperature sensor in it. Then use a wide enough fabric tape 
(e.g. from “Tesa” or “Scotch”) to attach the sensor firmly to the 
surface together with the heat conducting paste. 
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Please also make sure, that the sensor cable running to the data logger 
does not weigh down or loosen the measuring point. 
 
After completion of the installation work, we recommend that you 
briefly check the function of the individual sensors. To do this, select 
each sensor separately in the display by pressing the left “MAX” 
button of the data logger. 
 
First press the "MAX" button for approx. 3 seconds to bring the data 
logger into its initial state. Afterwards, a short push on the "MAX" 
button switches through the individual sensors. For further information 
on operating the Hygrofox with the help of the buttons, please refer to 
the enclosed quick guide. 
 
At the end of the measurement task, reconnect the data logger to the 
computer and readout the collected measurement data. The data can be 
transferred to the PC using the menu item "Transfer Data…" in the 
"Toolbox" menu. 
 

 
 

Figure 10: Reading out the collected measurement data 
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After the measurement values have been transferred to the computer, 
they are displayed directly as a diagram. You can use the diagram 
tools on the right-hand side of the diagram window to change the 
appearance of the diagram. To save the data, use the menu item "Save 
Project As…" in the "File" menu. 
 

 
 

Figure 11: Read out measurement data 
 

For more information on operating the software and configuring your 
data logger, please refer to the online help. 

 
Warranty Information and Liability 

 
The company Scanntronik Mugrauer GmbH grants a warranty of 24 
months on all of their data loggers. Re-calibration, battery replacement 
or shipping costs are not covered by the warranty (this list does not 
claim to be exhaustive). We assume no liability for direct or indirect 
damage caused by improper use or application of our devices. 
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Notes 
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